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A propos du manuel :
Ce manuel est structuré pour pouvoir vous permettre d'exploiter le robot MA-VIN selon plusieurs niveaux de connais-
sance et de difficultés.

Précautions

Ce manuel renferme des informations importantes qui devront impérativement étre suivies pour éviter tout dysfonction-
nement du robot MA-VIN ou tout dommage pouvant intervenir sur son utilisateur. Il est ainsi nécessaire de ne pas jeter
cette notice et de la conserver a disposition de tout le monde.

La base robotigue MA-VIN n’est pas un jouet. Il est impératif de la tenir HORS de portée de TOUS les enfants et plus
particulierement des enfants DE MOINS de 3 ans qui pourraient avaler ou inhaler les petites piéces qui la compose. Il
est également impératif de tenir les petits sacs qui renferment les composants hors de portée de TOUS les enfants afin
d’éviter des risques d'étouffements.

A propos de l'utilisation des piles :
Il est a noter que lors de circonstances exeptionnelles, des substances liquides peuvent s’écouler de certaines piles et
provoquer des brdlures chimiques ou endommager le MA-VIN. Pour éviter tout écoulement des piles :

- Utilisez UNIQUEMENT des piles de type alcaline.

- Retirez IMPERATIVEMENT les piles du MA-VIN si vous ne vous ne vous servez plus pendant plusieurs jours de
suite.

- Vérifiez la polarité des piles avant de les insérer dans leur compartiment.

- Ne JAMAIS laisser des piles usagées dans le compartiment du MA-VIN.

- Les piles usagées ne doivent JAMAIS étre jetées dans les ordures ménagéres. Débarrassez-vous de ces
derniéres dans un conteneur réservé a cet usage (pour plus d’information sur les lieux de collecte, veuillez
contacter votre mairie, votre service de traitement des déchets ou le magasin ou vous avez acheté les piles).

- Ne jetez JAMAIS les piles au feu (les piles pourraient exploser ou couler).

- Ne court-circuitez JAMAIS les bornes des piles.

- N’essayez JAMAIS de recharger des piles non rechargeables.

- Sivous utilisez une pile rechargeable (encore appelée accumulateur ou batterie), cette derniere doit étre
IMPERATIVEMENT retirée du MA-VIN avant sa charge. En cas d'utilisation d’une pile rechargeable, celle-ci doit
étre rechargée UNIQUEMENT par un adulte.

- La pile doit étre IMPERATIVEMENT laissée hors de portée des enfants de moins de 3 ans afin d’éviter que ces
derniers ne la portent a la bouche.

Les caractéristiques techniques et le design du produit peuvent étre modifiés sans avertissement préalable.

Dans tous les cas, si un écoulement de piles est mis accidentellement en contact avec les yeux de I'utilisateur, il est
impératif que ce dernier se rince abondamment les yeux et qu'il consulte immédiatement un médecin. De méme, si un
écoulement de piles est mis en contact avec la peau ou les vétements, il est impératif de rincer la peau ou le vétement
pour éviter une brdlure.

Ne mélangez pas des piles usagées avec des neuves ou des piles de différents types. Utilisez toujours un lot de piles
neuves du méme type quand vous remplacez les piles.

Utilisez un chargeur prévu pour la taille et le type de piles rechargeables et retirez toujours les piles du jouet avant de les
recharger.

Retirez les piles vides du produit.

Ne modifiez et ne démontez jamais les éléments du robot. Vous risqueriez de créer un court-circuit et un dysfonc-
tionnement de ce dernier.

N’appliquez aucune tension externe sur les éléments du robot et ne réalisez aucun court-circuit afin d’éviter sa destruc-
tion.

Manipulez le MA-VIN et ses modules avec précaution (évitez les chocs mécaniques et les chutes). Ne tournez pas
manuellement les roues du robot et ne soumettez pas le MA-VIN a des projections d’eaux.

N'appliquez jamais de substances chimiques inflammables (tel que le benzéne ou autre diluant) sur le robot
MA-VIN (son chassis plastique pourrait fondre ou s’enflammer). De méme, n’exposez jamais le robot a proximité
de substances corrosives telles que le camphre ou la naphtaline.
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Rappel sur I'’évacuation des équipements électroniques usagés

Ce symbole présent sur le MA-VIN et/ou ses emballages indique que vous ne pouvez pas vous débarraser de ce produit
de la méme facon que vos déchets courants. Au contraire, vous étes responsable de I'évacuation de ce produit lorsqu'il
arrive en fin de vie (ou qu'il est hors d'usage) et a cet effet, vous étes tenu de le remettre a un point de collecte agréé
pour le recyclage des équipements électriques et électroniques usagés. Le tri, I'évacuation et le recyclage séparés de
VoS équipements usagés permettent de préserver les ressources naturelles et de s'assurer que ces équipements sont
recyclés dans le respect de la santé humaine et de I'environnement. Pour plus d’informations sur les lieux de collecte des
équipements usagés, veuillez contacter votre mairie, votre service de traitement des déchets ménagers ou le magasin ou
vous avez acheté le produit.

Toutes les marques, les procédés et les références des produits cités dans ce document appartiennent a leur propriétaire
et Fabricant respectif. Les informations présentes dans ce manuel sont données a titre indicatif. Les caractéristiques
et possibilités du robot MA-VIN et de son logiciel de programmation peuvent changer a tout moment sans aucun préavis
dans le but d’améliorer les possibilités du produit.

Avant de lire le manuel du MA-VIN

Notre société contemporaine est en train de changer rapidement pour s’adapter a I'accroissement de la mise a dispo-
sition des informations mais également a 'omniprésence de machines toujours plus intelligentes. Tous les acteurs de
cette société ont pour but journalier de s’adapter de fagon la plus efficace possible a cet afflux d'informations afin de
répondre et de satisfaire aux besoins de chacun. Dans cette ére nouvelle, les robots intelligents joueront un role crucial
dans I'amélioration de la vie des populations en bouleversant nos modes de vies et nos cultures. A ce titre, Hitec robotics
Inc tient & préparer et a accompagner les usagers dans le bouleversement imminent qui attend notre société. Pour ce
faire, notre département Recherches et Développements (R & D) a créé une gamme compléte de robots intelligents édu-
catifs et ludiques intégrants des notions d'informatique.

Merci d’avoir fait I'acquisition du robot MA-VIN !
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Exploded View / Explosionszeichnung
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1. Comment assembler le MA-VIN

1.1. Assemblage du corps du MA-VIN

1. Vérifiez que vous disposez bien de tous les 2. Fixez le support de piles sur le chassis principal
éléments composants le robot a l'aide des vis

3. Fixez le bloc moteur de gauche. 4. Fixez le bloc moteur de droite.

5. Positionnez le couvercle des blocs moteurs. 6. Fixez le couvercle des blocs moteurs.

30f44
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7. Insérez le bloc « IR/ roue folle » sur le chassis.

9. Raccordez les connecteurs des différents
éléments sur la platine principale

11. Connectez les différents modules (LCD,
moteurs...sur leur support

8. Prenez la platine électronique principale.

10. Fixez la platine électronique principale sur le
chéssis.

12. Positionnez le couvercle de protection sur le
robot
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2. Composition du MA-VIN

2.1. Composition du produit

2.1.1. Liste de accessoires

No. | Composant Qté | Utilisation

1 Céble USB 1 Téléchargement MA-VIN
2 Platine de commande | 1 Platine intégrant le CPU
3 Module détecteur 1 Avec capteurs IR

4 Boitier pour piles 1 Pour 4 piles 1,5V AAA
5 Blocs moteurs 2 Moteurs réducteurs

6 Roues 2 Avec pneu gomme

7 Afficheur LCD 1 2 X 8 caracteres

8 Module HP 1 Pour restitution de sons
9 Module buzzer 1 Génération sonore

10 Module 7 segments 1 Affiche 0~9,A,B,C,D, F
11 Module Leds 1 4 Leds

12 Module capteur CDS 1 Perception luminosité

13 Capteur sensitif 1 Perception « touché »
14 Module « BP » 1 3 touches

15 Vis 1 Pour I'assemblage

2.1.2. Platine électronique de gestion du MA-VIN

5o0f 44
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No. Composant Désignation

1 Afficheur LCD Permet d’afficher des messages sur 2 lignes de 8 caractéeres
2 Led POWER (Led rouge) Permet de connaitre I'état de la tension d’alimentation 5 Vcc
3 Interrupteur « M/A » Permet de « mettre en marche » ou d’arréter le robot

4 Connecteur « DownLoad » (DL) Connecteur recevant le cable de téléchargement

5 Led « DownLoad » (Led verte) Permet de connaitre I'état du téléchargement

6 Connecteurs Moteurs Permettent le raccordement des moteurs

7 Connecteurs modules Permettent I'enfichage des modules d’extension (1~5)

8 Récepteur IR Permet la réception d’ordre de télécommande IR (non livrée)
9 Microphone Capteur permettant de détecter les bruits

10 Connecteur « Alimentation » Connecteur du + 5 Vcc

11 Connecteur « EXT » Connexion du + 5 Vcc (via une source externe)

2.1.3. Module ayant une fonction d’entrée/sortie
1) Modules « entrées »

Type

Module

Fonction

Module « BP »

Permet de connaitre I'état de 3 boutons-poussoirs.

Module « capteur CdS »

Permet de faire réagir le robot en fonction de la lumiére.

Module « Capteur sensitif »

Permet de faire réagir le robot en fonction de la sollicitation
d’'une zone sensitive.

Modle Microphone

Pré-intégré sur la platine de commande principale : Permet
de contrdler les réactions du robot en fonction des sons.

Module capteurs « IR »

Présents sur le dessous et les c6tés du chassis du robot,
ces derniers permettront au robot d’éviter des obstacles, de
suivre des lignes au sol...

2) Module « sorties »

Module

Fonction

Module « Buzzer »

Permet la génération de bips sonores.

Module « 7 segments »

Permet I'affichage d’'un nombre sur un digit 7 segments a
Leds.

Module « Leds »

Permet de piloter I'état de 4 Leds.

Module « LCD »

Permet I'affichage de textes sur 2 lignes de 8 caractéeres.

Module « Haut-parleur »

Permet la restitution différentes mélodies.

Module optionnel
« Moteur DC »

Module optionnel permettant de disposer de différents
réglages sur le fonctionnement des moteurs.
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2.1.4. Comment connecter les modules

a. Avant d’enficher ou de retirer un module, vérifiez que l'alimentation du robot soit bien « coupée ». Aidez-vous de
la sérigraphie et du texte représenté sur la platine principale pour positionner correctement les modules.

b. Vous disposez de 5 emplacements sur le robot MA-VIN pouvant recevoir les modules Buzzer, Leds, Afficheur 7
segments, Haut-parleur, Capteur sensitif, capteur CdS...)

c. Les modules LCD et récepteur IR sont pré-installés sur la platine. La télécommande infrarouge compatible avec
le récepteur IR sera commercialisée ultérieurement.

2.1.5. Raccordement du cable de téléchargement USB au PC

Le cable de téléchargement nécessite plusieurs étapes pour étre utilisé :

Connectez le cable USB sur le port USB d’'un compatible PC.

Connectez l'autre extrémité du cable USB sur le connecteur (Download) du robot MA-VIN.

c. Aprés avoir réaliser votre programme sous MA-VIN ROBOTICS LAB, téléchargez ce dernier dans le robot MA-
VIN.

d. Testez alors les réactions de votre programme sur le robot MA-VIN.

ocp
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2.2. Installation du logiciel MA-VIN ROBOTICS LAB

2.2.1. Avant l'installation

2.2.1.1. Qu'est-ce que le programme MA-VIN ROBOTICS LAB ?
MA-VIN ROBOTICS LAB est un logiciel qui vous permettra de déterminer comment devra réagir votre robot MA-VIN en
fonction de son environnement. A l'inverse des robots " standards " qui nécessitent généralement une programmation en
assembleur ou en langage " C ", le logiciel MA-VIN ROBOTICS LAB vous permettra de programmer votre robot par le
biais d'une interface graphique trés conviviale qui vous permettra d'appréhender trés facilement et rapidement les bases
de la robotique.

2.2.1.2. Configuration pour utiliser MA-VIN ROBOTICS LAB

La configuration optimale pour le logiciel MA-VIN ROBOTICS LAB est :
e 200 MB de libre sur votre disque dure (pour son installation)

100 MB de libre sur votre disque dure (pour son utilisation)

256 MB de mémoire vive (RAM)

Processeur Intel™ Pentium 1lI™ ou autre processeur compatible

OS Microsoft™ Windows 2000™ ou Windows XP™, etc.

2.2.2. Installation

Inséré le CD-ROM dans le lecteur de votre compatible PC et procédez en premier lieu a I'installation du driver de port
virtuel « USB <> UART ».

2.2.2.1. Installation du driver de port virtuel « USB <> UART »

Exécutez le programme CP2101_Drivers.exe. La
fenétre de droite apparaitra alors pour signaler le début
de la procédure d'installation.

La fenétre de présentation disparait alors au profit d’'une
seconde fenétre sur laquelle il vous faudra cliquer sur le
bouton « Suivant » (Next) pour commencer l'installation
du Driver.

Si vous étre d'accord avec les termes de la licence du
driver CP2101 de port virtuel « USB <> UART », cliquez
sur « Oui » (yes) pour continuer.
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Choisissez un répertoire pour l'installation du driver
CP2101 de port virtuel « USB <> UART » et cliquez
sur le bouton « Suivant » (Next) pour continuer.

Le répertoire par défaut est
“C:\SiLabs\MCU\CP2101".

L’installation du driver CP2101 de port virtuel « USB <>
UART » commencera alors.

2.2.2.2. Installation du logiciel MA-VIN ROBOTICS LAB

Aprés avoir complétement procédé a
l'installation du driver CP2101 de port virtuel

« USB <> UART », commencez a installer le
logiciel MA-VIN ROBOTICS LAB en suivant la
procédure ci-dessous .
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Double-cliquez sur le programme Setup.exe présent sur le CD « MA-VIN ROBOTICS LAB » pour débuter I'installation
et poursuivez en cliquant sur le bouton « Suivant » (Next).

Choisissez votre nom et celui de votre organisation (€cole, société..) et cliquez sur « Suivant » (Next).

Sélectionnez une installation “Complete” et cliquez sur « Suivant » (Next).
Le répertoire par défaut est “C:\Program Files\MA-VIN*
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MA-VIN ROBOTICS LAB est sur le point d’étre installé.

Cliquez sur « Install »pour commencer la procédure.
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Une fois l'installation terminée, cliquez sur “Finish”.

2.2.2.3. Installation manuel du driver USB

Ouvrez le panneau de contréle
et sélectionnez « Ajouter nouveau périphérique »

12 of 44



MA=—UIN

Si votre ordinateur détecte automatiquement un nouveau périphérique et vous propose d'installer le driver CP2101 de
port virtuel « USB <> UART » comme indiqué sur I'écran ci-contre, « sautez » directement les étapes 3 a 6 et continuer
votre lecture a partir de I'étape 7.

Si votre ordinateur ne détecte pas un nouveau périphérique, une fenétre d'installation manuelle devrait alors apparaitre
(voir écran ci-contre). Si le robot MA-VIN est raccordé au PC, sélectionnez I'option ‘Yes'.
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Sélectionnez le driver CP2101 de port virtuel « USB <> UART » et cliquez sur « Next ».

L’installation commence alors...

Une fois que la procédure « Ajout nouveau matériel » terminée, une fenétre « Nouveau matériel trouvé » devra
apparaitre
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Sélectionnez I'option ‘(Avancé)’ et cliquez sur « Next ».

Sélectionnez le répertoire qui renferme le driver comme indiqué ci-contre.

Veérifiez qu'il s’agisse bien du « bon » driver et cliquez sur « Next ».
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Installation.

L'installation du nouveau matériel est terminée lorsque le message « Completing The Found New Hardware » apparait.
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3. Utlisation des bases du logiciel MA-VIN ROBOTICS LAB
3.1. Configuration du MA-VIN ROBOTICS LAB

3.1.1. Fenétre principale

Menu principal reprenant les menus : Fichiers (File) — Source — Outils (Tool) — Vue (View) — Aide (Help)
Barre d'outils reprenant les icbnes des options du menu sélectionné

Modules logiques : Il s’agit des capteurs, conditions de branchement entre modules... nécessaires a la
programmation des mouvements du MA-VIN.

Modules de sortie : Il s’agit des modules de sortie du MA-VIN (module moteur, Leds...)

Base de travail : Il s’agit de I'emplacement utilisé pour la conception de votre programme.

Propriétés des modules: Indique la propriété des modules.

Etat de la programmation : Affiche I'état de la programmation du MA-VIN ROBOTICS LAB.

Modules € application » : Fonctions réalisées par certains modules de sorties et modules.

wnN e

© N oA

3.1.2. Menu d’affichage

Afin de pouvoir utiliser les fonctions du logiciel MA-VIN ROBOTICS LAB, l'utilisateur devra apprendre le rble des
différents menus et apprendre a maitriser I'usage de la barre d'outils. La barre d’outils reprend sous forme de boutons
graphiques les possibilités offertes par les fonctions présentent dans les menus Fichiers (File) — Source — Outils (Tool) —
Vue (View) — Aide (Help). En cliquant sur ces menus, d’autres sous-menus apparaitront alors afin de vous donner acces
aux fonctions du logiciel.

A l'usage, le recours aux boutons graphiques de la boite d’outils est bien plus rapide et convivial et devrait vous
dispenser dans la plupart des cas a avoir recours aux menus.

3.1.2.1. File(F)

Les menus Nouveau Fichier (New file), Ouvrir (Open), Sauvegarder (Save) et Sauvegarder comme (Save as)
correspondent aux fonctions de base permettant la création de programmes.
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3.1.2.1.1.New

Lorsque vous désirez réaliser un nouveau programme,
utilisez ce bouton pour créer un document vierge.

Vous pouvez également utiliser le menu
Fichier (File) -> Nouveau Fichier (New file)

3.1.2.1.2.0pen
Utilisez ce bouton pour récupérer un
programme déja sauvegardé (indiquez le
nom du fichier).
Vous pouvez également utiliser le menu
Fichier (File) -> Ouvrir (Open)

3.1.2.1.3.Save

Abb. 1 File > New
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Abb. 2 File > Open

Hew file

Save

Save as

Make app module

Module setting
End

Utilisez ce bouton pour sauvegarder votre programme (donnez un nom au programme que vous voulez sauvegarder — il
n'est pas nécessaire d'ajouter I'extension “.izi").
Vous pouvez également utiliser le menu Fichier (File) -> Sauvegarder (Save)

-

@ &

Seve vt L5 Poeat

A 3 By
et

I3 Application Example

- File s |

y BB

314 Remote Control

Sane am hpe

[@FlrR =

‘File(F) SourceiS) Tool(T)

New file
Open

Save as

Make app module
Module setting

End
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3.1.2.1.4.Save As
Ce menu s'utilise de la méme facon que le menu Sauvegarder, mais il permet de donner un autre nom au fichier que
vous allez sauvegarder.

3.1.2.1.5.Make app module
Making Application Modules : Ce menu est détaillé dans le chapitre VI (programmation en MA-VIN ROBOTICS LAB
(Utilisation des modules d’application)”.

3.1.2.2. Source(S)
Voir Source (View Source), Editer Source (Edit Source), Source Externe (External Source) -> Non disponible.

3.1.2.3. Tool(T)

Logic Check, Simulation, Compile, Download
A l'aide de ces menus l'utilisateur pourra contrdler si son programme ne comporte pas d’erreur de conception, le simuler,
le compiler en langage « C » et le télécharger dans le robot.

3.1.2.3.1.Logic Check

Utilisez ce bouton pour contréler si votre programme ne
comporte pas d’erreur de conception. A ce stade le logi-
ciel ne vous dira pas si votre programme fonctionnera
correctement, mais plus généralement si vous avez
laissé par exemple des connexions de libre ou utilisé
des modules de fagon incorrecte. Vous pouvez
également utiliser le menu Outils (Tool) -> Contrble
Logique (Logic check).

3.1.2.3.2.Simulation
Simule comment le programme fonctionnera « dans la réalité ».

3.1.2.3.3.Compile
Utilisez ce bouton pour compiler votre programme basé

sur des icones en langage « C ». « TookT) View(V) Help(

p - . — Logic check
Vous pouvez egalement utiliser le menu Outils (Tool) -> B _
Compiler (Compile) simulation

Download
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3.1.2.3.4.Download
Une fois le programme compilé, utilisez ce bouton pour "

transférer votre realisation au sein du robot (via le cable ] T':"?'_"E"_'_?_Vif’WF_"{?'_ H?H:r'f

USB). Vous pouvez également utiliser le menu Outils !

(Tool) -> Télécharger (Download). Logic check
Simulation
Compile
Download

3.1.2.4. View(V)

Ces boutons permettent de modifier le facteur de zoom de l'affichage des icdnes afin de rationaliser I'écran de travail. Si
votre programme nécessite un faible nombre d’icbnes, vous aurez intérét a augmenter leur taille. A l'inverse un grand
nombre d’icdbnes nécessitera que vous diminuer leur taille.

3.1.2.4.1.Zoom In

Utilisez ce bouton pour augmenter le facteur de zoom. -
Vous pouvez également utiliser le menu Vue (View) -> Q _Elﬂﬂ(\’} HE'..IEI(.H)

coom avant (zoom iy
£ 0 AT

| Zoom out

3.1.2.4.2.Zoom Out
Utilisez ce bouton pour diminuer le facteur de zoom. .
Vous pouvez également utiliser le menu Vue (View) -> Q Yiew(Y) Help(H)

Zoom arriére (Zoom out).

ZO0OMm in

Zoom out

Abb. 3 Zoom Funktion
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3.1.2.5. Help(H)

Ce menu affiche des aides diverses.

3.1.3. Modules : Modules Logiques, Modules de connexion, Modules de sortie

Afin de rationaliser la phase de programmation, le logiciel MA-VIN ROBOTICS LAB classe les différents modules en
catégories et fonctions. Généralement parlant, un module peut étre de type «logique » (tel que « Start », «end »,
« repeat » et « delay ») ou un module de type « connexion » (tel de « remote control » et « touch sensor ») ou encore de

type « sortie » (permettant de contrdler les mouvements du robot MA-VIN).

3.1.3.1. Modules Logiques

Les icones représentant les modules logiques (“start”, “end”, “modules de branchement”, “capteur de touche”...), sont

représentés en violets.

3.1.3.1.1.Modules logiques
Ces modules permettent d’indiquer le début et la fin du programme du MA-VIN.

Représentation ]
du module Module Fonction
Start Début du programme.
A utiliser pour sugnaler le début de votre programme
Repeat Répéte le programme autant de fois que le nombre indiqué
Permet de réaliser une « temporisation ». Sa valeur est
Delay comprise entre 1 et 65,535. Son uinité est la milliseconde

(1/2000 sec.)

End

Fin du programme
A utiliser pour signaler la fin de votre programme

3.1.3.1.2.Modules de connexion

Ces derniers sont également représentés en violet. |l s’agit d'un groupe de module capable de contrdler les modules
électroniques enfichables sur le robot MA-VIN.

Représentation .
du module Module Fonction
Remote En fonction de I'action d’'une télécommande (optionnelle) le
programme continuera sur I'icdbne du bas ou de droite.
Touch S/C En fonction de I'action détectée sur le capteur sensitif, le
programme continuera sur I'icdbne du bas ou de droite.
CDS S/C En fonction de l'intensité lumineuse détectée par le capteur

Cds, le programme continuera sur I'icbne du bas ou de droite.
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En fonction de l'intensité sonore captée par le microphone, le

MIC : oA :
programme continuera sur l'icdne du bas ou de droite.

En fonction des obstacles détectés par les capteurs IR latéraux
Photo et du dessous, le programme continuera sur I'icéne du bas ou
de droite.

En fonction du bouton-poussoir sollicité, le programme

Switch continuera sur 'icone du bas ou de droite.

3.1.3.2. Modules de sortie

Les modules de sortis sont représentés en rouge. lls permettent de solliciter différents organes de commande sur le robot
MA-VIN.

Représentation _
du module Module Fonction

Motor Actionne les moteurs selon différentes vitesse et direction.
LED Contr6le les Leds (ON/OFF)
Speaker Permet de restituer jusqu’a 10 mélodies.

Emet autant de bips sonores que le nombre indiqué dans cet

Buzzer icone.

LCD Affiche des textes sur I'écran LCD 2 x 8 caractéres

Music Permet de restituer sa propre mélodie.

FND Affiche un nombre de 0 a 9 sur I'afficheur 7 segments a Leds.
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3.1.3.3. Propriétés des modules et résultat de la programmation

Chaque module (a I'exception des modules logiques “start” et “end”) disposent de leurs propres propriétés. Vous appren-
drez le role de ces propriétés dans le chapitre lié a la programmation. De méme le « résultat de la programmation » vous

montrera I'état de la programmation apres avoir utilisé les commandes “logic check”, “compile”, et “download”. Vous
trouverez plus d’informations a ce sujet dans le chapitre suivant.

3.2. Programmation en MA-VIN ROBOTICS LAB (Les bases des Modules de mouvement)
La programmation du MA-VIN via I'environnement MA-VIN ROBOTICS LAB peut se résumer en plusieurs phases :

« Positionner les modules désirés sur I'écran principal.

« Configurer les parameétres des modules.

* Interconnecter les modules ensembles.

« Utiliser les boutons ‘Compile’ pour transformer le programme « graphique » en langage « C » et finalement télécharger
ce programme du PC vers le robot MA-VIN.

3.2.1. Positionnement des modules

Il s'agit de I'opération de base pour commencer a programmer dans I'environnement MA-VIN ROBOTICS LAB. Celle-ci
consiste a sélectionner et a positionnez les modules de fagon logique afin de « donner vie » au MA-VIN.

1. Pour ce faire, il vous suffit de sélectionner un module via un click gauche de souris, de le déplacer sur I'écran
principal (a un endroit inoccupé) et de réaliser un nouveau click gauche pour le « poser » sur la fenétre.

2. Aprés avoir « arrangé » la position des modules a I'écran, il vous suffira de les relier entres eux. Pour ce faire,
cliquez sur le bas d’'un module et sur le haut du module avec lequel il doit étre relié. Pour les modules a
branchement conditionnel, vous pouvez aussi (suivant les cas) connecter un module a un autre via son c6té droit.
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3. Aprés avoir connecté les modules entres eux, modifiez leurs propriétés (en sélectionnant ‘Modules Properties’).

3.2.2. Convertir le programme en Langage Machine

Cette procédure convertira le programme « graphique » (sur la base de vos modules) en langage machine via un pro-
cessus de controle de syntaxe et de compilation. Ce processus est automatisé des lors que vous sollicitez le bouton
“compile” présent dans la barre d’outils sans que vous ayez a vous soucier de quoi que ce soit.
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3.2.3. Télécharger le programme Compilé dans le robot MA-VIN

Ce processus vous permettra de transférer votre programme au sein de la mémoire du robot MA-VIN. Pour ce faire,
connectez le PC au robot MA-VIN via le cable USB et sollicitez le bouton “download” présent dans la barre d'outils.
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Note : Lorsque le robot MA-VIN et le PC ne sont pas connectés I'un a 'autre ou que le robot MA-VIN n’est pas « sous
tension », vous verrez alors apparaitre les messages d’erreurs ci-dessous :

Le PC et le robot MA-VIN sont connectés, mais le robot MA-VIN n’est pas « sous tension ».

Le PC et le robot MA-VIN ne sont pas connectés I'un a l'autre.
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4. Programmation en MA-VIN ROBOTICS LAB (Les base des différents modules)
4.1. Affichage sur le LCD

4.1.1. Caractéristique du « module LCD »

Le module LCD dispose de 2 lignes de 8 caractéres. Les
textes a afficher devront étre saisis entre “ ”. Le module
LCD n’accepte que des lettres standards (les caractéres
minuscules et majuscules sont reconnus)

4.1.2. Changement des parameétres

Réalisez un « click gauche » sur le module LCD pour af-
ficher ses parameétres. Essayez de saisir un texte com-
me par exemple “MyNamels” sur la premiéere ligne et
“MA-VIN” sur la deuxieéme ligne.

4.1.3. Fin de programmation; Téléchagement dans le MA-VIN

Une fois les paramétres du LCD configurés (et le le
schéma de droite réalisé), pressez les boutons ‘compile’
et ‘download’ pour télécharger votre programme dans le
robot MA-VIN. Une fois le téléchargement terminé, le
LCD devra afficher votre texte (comme le montre la pho-
to ci-contre)

4.2. Buzzer

4.2.1. Charactéristique du « module Buzzer »

Le module Buzzer permet de solliciter une sonorité au
niveau du buzzer. Le buzzer ne peut émettre qu’un seul
type de son.
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4.2.2. Modification des paramétres

Réalisez un « click gauche » sur le module buzzer pour
afficher ses paramétres. Le parameétre “Position” indique
la position « physique » (1 a 5) sur laquelle le module
(réel) a été inséré sur le robot. Le parameétre “Number”
détermine le nombre de fois que le buzzer devra étre
sollicité.

4.2.3. Activation du Buzzer

Une fois les paramétres du Buzzer configurés, réalisez
le schéma de droite. Pressez ensuite les boutons
‘compile’ et ‘download’ pour télécharger votre
programme dans le robot MA-VIN. Une fois le
téléchargement terminé, le buzzer devra émettre des
sonorités autant de fois que le nombre indiqué dans la
fenétre de ses parametres.

4.3. Pilotage du « module LED »

4.3.1. Caractéristiques du « module LED »
Le module LED permet le pilotage (allumées ou éteintes) indépendant ou simultané de 4 Leds.

4.3.2. Modification des paramétres

Réalisez un « click gauche » sur le module LED pour afficher ses parameétres. Sélectionnez la position du module sur le
robot (1 a 5). Le paramétre “Value” contréle les 4 Leds (avec un pilotage indépendant ou simultané).
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4.3.3. Allumer ou éteindre les leds

Positionnez les modules Leds a I'écran, compilez et
téléchargez le programme dans le MA-VIN afin que les 4
Leds s'allument et s’éteignent en méme temps. Tou-
tefois vous pourrez constater que la durée d'allumage
des leds est trop bréeve. Comment modifier cette du-
rée ? Cette durée ne peut pas étre déterminée dans le
module Led en lui-méme (car rien ne le permet dans ses
parametres). En revanche, nous avons vu dans la des-
cription des modules qu’il existait un module « delay »
spécial qui devrait résoudre notre probleme en linter-
calant entre les modules d’allumage et d’extinction des
Leds. Ajoutez alors ce module (configuré pour une tem-
porisation d'une seconde), compilez et téléchargez a
nouveau le programme pour vérifier que les leds restent
allumées une seconde avant de s’éteindre.

4.3.4. Allumer et éteindre les Leds consécutivement

Maintenant modifions le programme pour allumer et éteindre successivement les 4 Leds en se servant de ce que nous
venons d’apprendre.

Aprés avoir réalisé le programme ci-dessus, compilez-le et téléchargez le dans le robot MA-VIN. Vérifiez que les Leds
s’allument et s’éteignent bien successivement. Vous pouvez contréler individuellement la durée de 'allumage de chaque
Leds via les modules "Delay".

4.4. Compteur via le module « FND »

4.4.1. Caractéristiques du module « FND »
Le module « FND » (aussi connu sous le nom d’afficheur 7 segments) permet I'affichage d’'un nombre.

Affichage des nombres 0 a 9 en utilisant un module « FND »
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4.4.2. Modification des Parametres

Réalisez un «click gauche » sur le module « FND »
pour afficher ses parametres. Le paramétre “Position”
indigue la position « physique » (1 a 5) sur laquelle le
module (réel) a été inséré sur le robot. Le paramétre
“Number” détermine le nombre a afficher sur le module
« FND ».

4.4.3. Compteur utilisant le module « FND »
Aprés avoir réalisé le programme ci-dessus, compilez-le et téléchargez le dans le robot MA-VIN. Vérifiez que le module
« FND » réalise bien I'opération de comptage.

4.5. Génération de mélodies (1)

4.5.1. Caractéristiques du module « Haut-parleur »
Le module « Haut-parleur » permet de restituer une mélodie. La version actuelle du MA-VIN ROBOTICS LAB permet de
sélectionner 10 mélodies différentes.
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4.5.2. Modification des paramétres

Réalisez un «click gauche » sur le module « Haut-
Parleur» pour afficher ses parameétres. Le paramétre
“Position” indique la position « physique » (1 a 5) sur
laquelle le module (réel) a été inséré sur le robot. Le
parameétre “Melody Type” (1 a 10) détermine la mélodie
gue le haut-parleur doit restituer.

4.5.3. Restituer différentes mélodies

Afin de tester et d'écouter les différentes mélodies, réali-
sez le programme ci-contre, compilez-le et téléchargez
le dans le robot MA-VIN. Ecoutez ensuite les différentes
mélodies disponibles.

4.6. Génération de mélodies (2)

4.6.1. Caractéristiques du « module de composition »

Le « module de composition » peut (comme le module « Haut-Parleur ») reproduire des sons sur le Haut-Parleur du robot
MA-VIN. Toutefois a l'inverse du « module « Haut-Parleur » qui jouera une mélodie compléte, le « module de composi-
tion » restituera uniguement des notes pouvant étre choisies par l'utilisateur (afin qu'il puisse composer ses propres meé-
lodies).

4.6.2. Modification des parametres

Réalisez un « click gauche » sur le module « module de composition » pour afficher ses parametres. Le paramétre
“Position” indique la position « physique » (1 a 5) sur laquelle le module (réel) a été inséré sur le robot. Le parametre
“Pitch” détermine la note & jouer depuis le premier octave 1 G jusqu'a 3E. Le paramétre “Rhythm” permet un acces de la
32°™ note a la demi-note
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4.6.3. Creéation de sa propre mélodie
Utilisez plusieurs « module de composition » pour créer votre propre mélodie.

4.7. Déplacement du robot MA-VIN

4.7.1. Caractéristiqgues du « module Moteur »

Le module « Moteur » est une des principales bases du robot MA-VIN puisqu’il lui permettra de se déplacer. Le module
« moteur » permet également de piloter d’autres moteurs externes (utilisable en option ultérieurement).

4.7.2. Modification des paramétres

Réalisez un « click gauche » sur le « module moteur »
pour afficher ses paramétres. Le parametre “Position”
indique la position « physique » (1 a 5) du module (réel).
De base, sélectionnez “basic motor” (la gestion de
moteurs externes sera disponible ultérieurement). Le pa-
rametre “Direction” permet de sélectionner le sens de
rotation (avant / arriere). Le parametre “Select Motor”
permet de sélectionner la roue droite “Right motor” ou
gauche “Left motor” que vous voulez solliciter. Le para-
metre “Velocity” contréle la vitesse de rotation (valeur de
1a17).

4.7.3. Faire tourner le robot MA-VIN dans un sens

Aprés avoir réalisé le programme ci-dessus, compilez-le
et téléchargez le dans le robot MA-VIN. Admirez alors le
résultat et la réaction du robot !

4.7.4. Faire déplacer le MA-VIN en avant / en arriére / a droite / a gauche

A titre d’exercice, en exploitant correctement le « module moteur » essayez de déplacer le robot MA-VIN selon un trajet
représentant une croix (en avant, en arriére, a droite, a gauche).
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5. Programmation en MA-VIN ROBOTICS LAB (Utilisation des modules capteurs)
5.1. Réalisation d’une sonnette de porte via le capteur sensitif (1)

5.1.1. Caractéristiques du module « capteur sensitif »

Le module « capteur sensitif » dispose d'une zone sensible sur sa face avant. Si vous touchez la partie argentée, il
détectera votre doigt et allumera sa Led.

5.1.2. Modification des parametres

Réalisez un « click gauche » sur le module « capteur
sensitif » pour afficher ses paramétres. Le paramétre
“Position” indique la position « physique » (1 a 5) sur
laquelle le module (réel) a été inséré sur le robot. Le
parametre “Affirmation condition” affiche ‘true’ ou ‘false’.
Lorsque c’est ‘true’, le capteur a percu un « touché » et
lorsque c’est ‘false’, le touché n’a pas été détecté.

5.1.3. Sonnette avec module « Buzzer »

Afin de réaliser une sonnette qui s'activera lorsqu’on sol-
licitera le module « capteur sensitif », saisissez le sché-
ma ci-contre. Pour cet exemple, on mettra aussi a profit
le module ‘repeat’ (voir explication sur ce module en pa-
ge 29) afin de simuler la réaction du bouton de la son-
nette. Compilez et téléchargez le programme dans le
robot et tester le résultat.
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5.1.4. Sonette a mélodie

Afin de réaliser une sonnette qui restituera une mélodie
en affichant le message “Guest” sur I'écran LCD, sai-
sissez le programme ci-contre. Ici on mettra aussi a pro-
fit le module ‘repeat’ afin de simuler la réaction du bou-
ton de la sonnette. Compilez et téléchargez le program-
me dans le robot et tester le résultat.

5.1.5. Réalisez votre sonnette personnalisée
A titre d’exercice, réalisez votre propre sonnette laquelle devra étre capable de restituer un air musical personnalisé.

5.2. Fonction alarme

5.2.1. Restituer une mélodie aprés 10 secondes
Voici d’autres exemples d’exercices a réaliser :
- Programmez le MA-VIN pour gu'il restitue une mélodie 10 secondes apres qu'il aura commencé a se déplacer.
- Augmentez la difficulté en utilisant le module « FND » pour afficher en plus un décompte de 9 a 0 avant de restituer
la mélodie.

Essayez de réaliser cet exercice seul avant de consulter la réponse a la page suivante.
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5.2.2. Génération d’une mélodie a la lumiere du jour - Caractéristiques du module « CdS »

Lors d'un exercice précédent nous avons réalisé une alarme sonore qui s’est déclenchée aprés une certaine durée.
Maintenant réalisons une alarme qui réagira lorsque le robot sera exposé a la lumiere. Cette détection sera rendue
possible grace au module « CdS » qui intégre un capteur dont la résistance électrique change en fonction de la lumino-
sité détectée par ce dernier.

5.2.3. Modification des parameétres

Réalisez un « click gauche » sur le module « CdS » pour afficher ses paramétres. Le parameétre “Position” indique la
position « physique » (1 a 5) sur laquelle le module (réel) a été inséré sur le robot. Le paramétre “Luminance” détermine
le niveau de luminosité a partir duquel le module enverra une réponse au robot. Le paramétre “Affirmation condition”
affiche soit ‘true’ ou ‘false‘. Lorsque “Affirmation condition” est ‘true’, cela signifie que la lumiére captée par le module
« CdS » est supérieur ou égale a la valeur de consigne “Luminance”. Lorsque le parameétre “Affirmation condition” est
‘false’, cela signifie que la lumiére captée est inférieure a la valeur de consigne “Luminance”.
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5.2.4. Réalisation d’un réveil matin
A titre d’exercice, transformez votre robot en réveil matin qui sonnera lorsqu’il détectera la lumiére du jour !

5.3. Alarme antivol

5.3.1. Caractéristiques du module « Microphone »

Le module « microphone » est une sorte de capteur qui réagit aux bruits ambiants. Ce dernier pourra se comporter diffé-
remment suivant l'intensité sonore captée. Contrairement aux autres modules, le module « microphone » est déja pré-
installé sur la platine principale du robot MAVIN.

5.3.2. Changing Parameters

Réalisez un « click gauche » sur le module « microphone » pour afficher ses paramétres. Le paramétre “Sound intensity”
peut étre réglé de 1 a 5. Le paramétre “Affirmation condition” peut prendre la valeur ‘true’ ou ‘false’. Lorsque “Affirmation
condition” est a ‘true’, I'intensité sonore captée par le module microphone est plus grande ou équivalente a la valeur de
consigne programmable en “Sound intensity”. Lorsque “Affirmation condition” est a ‘false’, cela signifie alors que le niveau
sonore capté est inférieur a la valeur de consigne. Comme vous pouvez le constater, il n'existe pas de paramétre “loca-
tion” comme sur les autres modules (car pour rappel, le module « microphone » est déja pré-installé sur la platine prin-
cipale du robot MA-VIN).

5.3.3. Réalisation d’une alarme antivol

A titre d’exercice, réalisez maintenant une alarme antivol a I'aide de votre robot MA-VIN afin que ce dernier puisse se
mettre automatiquement sous surveillance a la tombée de la nuit en s’assurant alors qu’aucun bruit suspect ne soit capté.
A ce stade la Led 1 de son module Led devra s’allumer pour signaler qu'il est sous surveillance. En cas de détection de
bruit « anormal », I'écran LCD devra afficher le message “Burglar” et le buzzer devra étre activé. Enfin il vous faudra
prévoir la possibilité de stopper le fonctionnement du buzzer et I'affichage du LCD sur simple sollicitation du module
« capteur sensitif ». Essayez de réaliser cet exercice seul avant de consulter la réponse a la page suivante.
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5.4. Télécommande infrarouge du MA-VIN

5.4.1. Caractéristique du module de « réception d’ordres infrarouges »

Le module ‘Remote Control’ permet au robot MA-VIN de pouvoir étre piloté via une télécommande infrarouge optionnelle.
Les ordres de la télécommande seront captés par le récepteur infrarouge pré-installé sur la platine principale du robot
MA-VIN.

5.4.2. Modification des Parametres

Réalisez un « click gauche » sur le module « Remote Control » pour afficher ses parametres. Le paramétre “ Setting
Value” vous permet de déterminer la touche de fonction de la télécommande. Le paramétre “Affirmation condition” peut
étre a ‘true’ ou ‘false’. Lorsqu'il est a ‘true’, ceci indique que la touche sollicitée sur la télécommande correspond a celle
sélectionnée dans le parametre “Setting Value”. Lorsque “Affirmation condition” est a ‘false’, ceci signifie que la touche
sollicitée sur la télécommande est différente de celle sélectionnée dans le paramétre “Setting Value”.
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5.4.3. Modifier I'affichage du module « FND » via la télécommande infrarouge

Essayez maintenant de réaliser un programme vous permettant de modifier la valeur du nombre affiché par le module
« FND » & partir de la télécommande infrarouge optionnelle. Dans le paramétre “Set Value” du module, “Move Forward”
sera représenté par ‘1’, “Move Backward” par ‘2’, “Move Left” par ‘3’ et “Move Right” par ‘4.

De méme, le message “Nothing” devra s’afficher sur I'écran du LCD si aucune commande n’est
reconnue Essayez de réaliser cet exercice seul ou aidez-vous du schéma ci-dessous en compilant et
en téléchargeant ce dernier dans le robot afin de tester le résultat.

5.4.4. Télécommande infrarouge du MA-VIN

Essayez maintenant de réaliser un programme vous permettant de piloter le robot MA-VIN (marche avant, arriére, a
droite et a gauche) a l'aide de la télécommande infrarouge optionnelle. Essayez de réaliser cet exercice seul ou aidez-
vous du schéma ci-dessous en compilant et en téléchargeant ce dernier dans le robot afin de tester le résultat.
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6. Programmation en MA-VIN ROBOTICS LAB (Module « bloc infrarouge IR »)
6.1. Caractéristiques du module « bloc infrarouge IR »

6.1.1. Caractéristigues du module « bloc infrarouge IR »

Le module « infrarouge bloc IR » est composé de 6 Leds infrarouges et phototransistors. 3 de ces derniers sont placés
devant le bloc et les 3 autres sous le bloc. Les Leds « latérales » placées sur le devant permettront au robot MA-VIN
d’éviter les obstacles qui se présentent devant lui. Les Leds « inférieures » placées sous le bloc permettront au robot MA-
VIN de connaitre la nature du revétement sur lequel il se déplace (pour suivre des lignes au sol par exemple).

6.1.2. Modification des Parametres

Réalisez un « click gauche » sur le module «Front
/Rear » pour afficher ses parametres. Le parame-
tre “Sensor Direction” détermine si vous voulez
utiliser les capteurs latéraux (‘Forward’) ou infé-
rieurs (‘Backward’) du « infrarouge bloc IR ». Le
parameétre “Sensor Status” permet d’identifier une
situation spécifique que le robot MA-VIN doit re-
connaitre. Si le parameétre “Affirmation condition”
est ‘true’, le module « infrarouge bloc IR » aura
détecté la situation identifiée par le parameétre
“Sensor Status”. Si le parametre “Affirmation con-
dition” est ‘false’, la situation en question n'aura
pas été détectée.

6.1.3. Piloter le module « FND » a partir du module « bloc infrarouge IR »

Essayez maintenant de réaliser un programme vous permettant de modifier I'affichage des nombres sur le module
« FND » en fonction de ce que détecte le « bloc infrarouge IR » du robot MA-VIN. En cas de détection sur I'avant du
« bloc infrarouge IR » I'affichage devra étre 1, 2 ou 3 (suivant que le module détecte un obstacle a gauche au centre ou a
droite). L'affichage devra étre un nombe compris entre 4 et 6 en fonction de la détection effectuée sur les capteurs placés
au dessous du « bloc infrarouge IR ». Si aucun des capteurs n’est sollicité (tous les paramétres “Affirmation condition”
sont en ‘false’) I'affichage sur le module « FND » doit étre également différent. Pour vous aidez vous pouvez réaliser le
programme ci-dessous ou télécharger le programme « ER6 » et tester le résultat.
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6.2. Robot MA-VIN « éviteur d’obstacles »
Réalisons maintenant un robot mobile capable d’'éviter les obstacles grace a ses capteurs latéraux..

6.2.1. Programmation du Robot MA-VIN « éviteur d’obstacles »

Afin de pouvoir réaliser le robot MA-VIN « éviteur d’obstacles » il vous faudra configurer le paramétre “Sensor Direction”
du module « bloc infrarouge IR » en ‘Forward’ et modifier le comportement et le pilotage des blocs moteurs en fonction
des situations définies dans les parametres “Sensor Status”. Réalisez ce programme et téléchargez le dans le robot pour
tester le résultat. Afin de rendre le déplacement du robot plus « visuel », le module « FND » vous indiquera quels sont les
détecteurs du « bloc infrarouge IR » qui sont sollicités.
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6.3. Robot MA-VIN « suiveur de ligne »

Réalisons maintenant un robot mobile capable de suivre une ligne au sol grace aux capteurs inférieurs du module « bloc
infrarouge IR ».

6.3.1. Programmation du robot MA-VIN « suiveur de ligne »

Afin de pouvoir réaliser le robot MA-VIN « suiveur de ligne » il vous faudra configurer le parameétre “Sensor Direction” du
module « bloc infrarouge IR » en ‘backward’ et modifier le comportement et le pilotage des blocs moteurs en fonction des
situations définies dans les paramétres “Sensor Status”. Réalisez ce programme et téléchargez le dans le robot pour
tester le résultat. Afin de rendre le déplacement du robot plus « visuel », le module « Leds » vous indiquera quels sont les
détecteurs du « bloc infrarouge IR » qui sont sollicités.

42 of 44



MA=—UIN

7. Programmation en MA-VIN ROBOTICS LAB (Utilisation des Modules Applications)
7.1. Modules Applications

7.1.1. Réaliser un module Application
Sélectionnez le menu ‘Making Application Modules’ dans le menu principal

Aprés avoir modifié le nom du module, sauvegardez-le.
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Cliquez sur « Application Output Module » pour voir les « Modules Application ».
« Rangez » les modules comme ci-dessous et téléchargez le programme dans le MA-VIN.
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